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UNIT-I 
 

COMPUTER BASICS 
 

You will learn 
 

 
 
 
 
 
 
 

Introduction to Computer 

 Introduction to computer 
 Identify the parts of computer 
 Starting and shutdown the computer 
 Computer Room Etiquettes 
 Identify the keys of keyboard 
 Do’s  and  Do  not  of  while  working  on 

computer 
 Strengths and Limitation of Computer 

 
Computer is an electronic machine. It runs on electricity. It takes inputs from you. It uses 
some program (set of instructions) to process these inputs. Finally it delivers output as per 
your requirement. It can also store your data. You can retrieve this data later on. 
Computer follows “Input-Process-Output” Cycle. 

 

 
 

Parts of Computer and their functionality 
 

Computer comprises of different parts which are connected with each other. 
Each part of Computer plays very important role whenever we use a computer. 

Main parts of computer are 
 

 
 

Monitor/LCD 
It displays whatever you 
type or draw on computer. 

 
Central Processing Unit 

It controls the functioning 
of other components. 

Keyboard 
It is set of typewriter like 
which types the text through 
keys. 
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Mouse 
It is used to point items and 
select the text on the screen. 

Speaker 
It is used for audio output 
from the computer. 

Printer 
It is used to take printout 

on the paper. 

Starting and shutting down the computer 
 To start a computer we should flow the following steps 

1. Plug in your computer and all peripheral (all devices attached). 
2. Switch On your UPS which provide uninterrupted power supply to your computer. 
3. Press power button of your CPU then computer will be boot up. 

  To Shut down your computer 
1. To turn off your computer click on the start button. 
2. Then in the lower right corner of the start button click on the shut down. 
3. When you click shut down computer will ask to close all program you opened and 

close them . 
 

Computer Room Etiquettes 
1. Remove your shoes before entering the Computer Room because your shoes contain 

dust which can harmful for any electronic equipment including computer. 

 
2. Open the door of Computer room slowly and enter it calm and quietly. 
3. Never touch the computer parts and attached cables as they can be harmful for 

both (Computer & you).  

4. Do not push each other while standing near a computer. 
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5. Sit  down  calm  and  quietly  while  seeing  Demo  on  the  computer.  Ask  questions 
whenever you are given chance for it. 

 
 

6. Never carry magnets inside the computer room. 
 

 
 

7. Keyboard of your computer should be handled gently. 
 

 
 

8. Please do not eat anything such as chewing gum, bubble gum and other sticking 
things inside the computer room. 

 
 
 
 

9. Never  keep any things  such as  books, notebooks, pencil  boxes  on the monitor, 
keyboard or CPU. 

 
10. Always use soft and dry clothes to clear the various parts of a computer. 

 
11. Always Shut down your computer properly and cover it with clean clothes before 

leaving the computer room. 
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Identify the keys on keyboard- different keys on keyboard 
Keyboard looks like a typewriter. It is made up of different types of Keys. These keys are 
small buttons on the keyboard. Alphabets in Capital letters, numbers, some special 
characters, are printed on the keys whenever we press the keys whatever is written on the 
keys will printed on the screen. 

 

 
 

Some of important keys 
 

Alphabetical Keys:-A,B,C………………………………Z are alphabets keys. There are 26 alphabet 
keys on the keyboard. Whenever we press these keys associated alphabet in small case is 
written in the screen.  

Numerical Keys:- 0,1,2,…………………………9 are numeric keys. There are 10 numeric keys on the 
keyboard. 

 
 
 
 
 
 

Special Keys: There are various special keys 
Caps Lock: – This key is used whenever we want to type the entire sentence, whole word 
and letter in a capitals. To use this key press it once and see the yellow light on the right 
corner of keyboard where the Caps Lock is written on a button. If the light is on it means 
the Caps Lock is active. If we want to write in small case then press this button again the 
Caps Lock is off now.  

Enter Key:- This key is used to finish a line and move to  a  next new line on the page. 
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keyboard. 

 
 

Shift Key:-Shift key is present on both sides of the keyboard. The Shift key is 
modifier key on a keyboard .The shift key is a modifier key on a keyboard, used to 
type capital letters and other alternate "upper" characters. There are typically two shift 
keys, on the left and right sides of the row below the home row. 

 

 
Space Bar:-This key is used to insert the space between two word. It is the longest key on 
the keyboard. 

 
 

Backspace:-is used to delete any character before the current position of the cursor. 
 

 
 

Arrow Keys:-is used to move the cursor position in all directions (left, right, up and down) 
in the page. 

 
 

 
Identify the buttons of Mouse- description of different buttons on the mouse. 

 
 

 
1. Left mouse button is used to point to any menu, tool, icon and selection of text, 

face, surface and we can select multiple entities by this button. 
2. Wheel is used to scroll the page up and down. 
3. Right mouse button is used to invoke the shortcut menu. 

 
 

 Do’s and Don’ts of Computer Lab  
 

1. Remove your shoes before entering in the computer Lab. 
2. Wash and dry your hands before touching computer parts. 
3. No Food and Drink is allowed in the Computer Lab. 
4. Work Quietly in the Computer Lab. 

 
 

COMPUTER FUNDAMENTAL 

Enter  key  is  pressed  after  typing  every  command.  There  are  two  Enter  key  on  the 
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6. Do not install or download any software or modify or delete any system files on any lab 

computers. 

 
7. Search through internet must remain for academic purposes. Only Visit the approved 

Websites through Internet. 
8. Operate the computer equipment properly. 

 
Strengths and LIMITATIONS of Computer 

Strengths 
1. Fast- Computers are much faster as compared to human being. 
2. Accurate – Computer can perform all calculation accurately. 
3. Store Large amount of data- We can store large amount of data in the 

computer. 
4. Reliability- Computers are more reliable than human. 
5. Versatile-Computer can perform variety of operations on the same data set. 

 
Limitations 

1. No IQ level 
2. Works on electricity 
3.   Cannot think by itself. 
4.  Unable to take decision. 

 
 

COMPUTER FUNDAMENTAL 

5.  Do not change any computer setting. 

Page 8 K e n d r i y a V i d y a l a y a S a n g a t h a n 
 



 

 

 

Let us do practice now 
 

TYPE-I (Short answers based questions) 
1. Write down the function of the following keys 

(i) Caps Lock Key (ii) Space bar key 
2. What is the purpose of scroll button of the mouse? 
3. Why should one take some precautions in the Computer room? 
4. Draw / paste the picture of a Computer. 
5. How can a computer be used for 
6. (i) Education (ii) Medical? 
7. Write down any two things you should do in the Computer room and also you should not 

do. 
8. State what would happen if 

a. We clean the computer with a wet cloth. 
b. We play with wires and clothes in the computer room. 
c. We wear shoes in the computer room. 
d. We are harsh in handling the keyboard. 
e. We do not cover the computer with clean clothes when not using them. 

 
TYPE-II (Fill in the blanks) 

 
1. Computer has parts. 
2. Monitor looks like a . 
3. The computer is an machine. 
4. In schools, computer is used to teach subjects. 
5. Versatile means . 

 
Type-III(True or False) 

 
1. Computer can solve only mathematical problems. (True/False) 
2. Mouse is used for clicking.(True/False) 
3. Monitor is used for displaying output. (True/False) 
4. The backspace key is used to insert characters. (True/False) 
5. Computer is very slow machine. (True/False) 
Lab Session 

 
Type the following line 
1. My name is .(your name) 
2. I Live in .(your address) 
3. I like my school very much. 
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Colour of 
the line 

Using pencil tool 

 

 
 
 

FUN WITH PAINT BRUSH 
 

You will learn 
 

 Introduction 
 How to start Paint brush. 
 Home Tab 
 Pencil,  Eraser,  Fill  with  color, 

pickcolor, brush, Air brush 
 Text tool, Shapes, Magnifier 

 
Paintbrush is used for drawing, coloring and editing the pictures. We can use Paint Brush 
like a digital sketchpad to make simple pictures. Files created in Paint Brush are saved as 
bitmap files. The default file extension of a bitmap file is .bmp. 

 
Steps To open Paint Brush 

Click Start-> All Programs Accessories Paint. 
 

 
Options on Home Tab- Paste, Cut, Copy, Select, Crop, Resize, Rotate, Brushes, Shapes, Line, Color 
options 

 
 

    This tool draw a freeform line with the selected line width. 

To draw a free form line. 
 

1. Click the pencil tool in the tool 
box. 

2. Select a colour from the color 
box. 

3. You can change the thickness 
of the line by selecting the 
lines given in the line patterns. 
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Width of the free form line 
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Fill With color- This tool help to fill an area or object with selected colour. 
 
 

Fill with color 
 

1. Select a fill with color tool from 
toolbox. 

2. Choose a color you want to fill in a 
picture from colour platelets. 

3. Click fill with colour tool in the 
image. 

 
 

    Pick Color- By this tool, Color is selected from one part of the object and can 
be used to color other areas. Left click is used for back color and right click for 

foreground color. 
 

   
 

Before Selecting pick color- Back and front color After Selecting Pick color- Back and front color 
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Eraser/Color Eraser- 
 
This tool is useful for erasing part of the 
image. 

To erase an image 
 

1. Select the eraser tool from 
toolbox. 

2. Increase the size of the eraser 
from size line given in the tool box. 

3. Hold the eraser where you want to 
erase a part of the image or whole 
image. 
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Text- To add text to the drawing. 
 

 
 

Steps to add Text 
1. Click the text tool in the tool box. 
2. Create a text frame by clicking and 

dragging the mouse pointer across. 
3. Then Text tab will be appear on the 

top as menu shown above. 
4. Choose the font style, size from the 

font toolbar. 
5. Click  in  the  text  frame,  and  type 

your text. 
6. To  change  the  colour  of  the  text, 

click a colour in the Color box. 
7. Click  outside the text frame, once 

text has been done. 

 
 

Coloured with fill with colour 

Using Airbrush. 
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Brushes-This tool paints the image with various kinds of brushes available in toolbox. 
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    Magnifier- is used to see the picture or object in enlarged form. Choose a 

magnifier the left click mouse button will ZOOM In and right click will ZOOM 
OUT the picture. 

 

   
 

  
 

Magnifier- ZOOM IN Magnifier- ZOOM OUT 

 
 

 
 

COMPUTER FUNDAMENTAL 

Shapes- To draw different shapes click on the shape you want to draw 
and drag the pointer across the drawing area. 
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TYPE-I (Short answers based questions) 
 

1. Name and Draw few tools of Ms-Paint. 
2. What is the effect of Magnifier tool ? 
3. Name different options available on the text menu. 
4. What is difference between paint brush and Air brush. 

 
 

TYPE-II (Fill in the blanks) 
 

1.   is used to fill an area with color. 
2.   enlarges or reduces the picture. 
3.   is used to erase part of the picture. 
4.   is used like paint spray. 

 
Type-III(Match the following) 

 
 SELECT 

 TEXT 

 ERASER 

 PENCIL 

 COLOR 
PICKER 

 
 
 

Lab Session 
 

1. Draw the picture in Ms-Paint 
 

 
 

2. Design one colored scenery with some text message. 
3. Draw a rainy scene and describe in five lines. 
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Let us do practice now 
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MORE ABOUT PAINT BRUSH 
 

You will learn 
 

 Selection-Rectangular Selection, 
Freeform Selection 

 View Menu 
 Zoom In 
 Zoom Out 
 Full Screen 

Select- This tool is used to select the particular part of the image with different 
shapes. 

 
 
 
 
 

 
Selection shapes 

1. Rectangular selection 
2. Free-form selection 

 
Rectangular selection 

 
    This tool is useful for selecting the whole or a part of an 

object in a rectangular form. 
 

Steps for using Select tool 
 

Choose the select tool ->Click and drag on the part of picture, which you want to select. 
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A dashed rectangle will appear around your selection, with the move cursor   replacing 
the cross-hair one. You can press this cursor down anywhere inside your selection and drag 
to move it, or drag while holding the Ctrl key to make a copy of it. 

 
Freeform selection 

 
This tool is used to select an object in irregular form. Free-Form Select is also 
understood in coloring parts of black and white images and vice versa. 

 

 
 

Select the  free  form select tool by using mouse  pointer->Point to  the  image  to be 
selected-> click and drag on the area, which you want to select. 

 

 
 

After clicking Freeform selection, drag your mouse around the area you want, as though 
you were  drawing a line  around it. When you release the mouse button,  a selection 
rectangle will appear and it may seem that unwanted parts of the drawing have been 
included, but if you move the selection you'll see that this is not so. 

 
View Menu-View Menu contains the following options 
Zoom In, Zoom Out, 100%, Ruler, Full screen 

 
Zoom In- This option is used to view image in enlarge mode. It represent the closer view 
of a image. 
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Full Screen-This option is used to see the Full View of the screen. You can also use Full 
screen option by pressing F11. Only image will be displayed without any tools.You can 
return back to original screen by clicking anywhere on the screen. 

 

 
 

 

Let us do practice now 
 

1. Write the function of Zoom option? 

2. Make a list of options available in View menu? 

3. What is difference between Free from Select and Rectangular Selection? 

Lab Session 
 

1. Make different shape in Ms-Paint view it in Zoom in and Zoom out. 
 

2. Select images using free form selection – selecting flower. 
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Zoom Out- used to distant view of an image. 

Page 18 K e n d r i y a V i d y a l a y a S a n g a t h a n 
 



 

 

 
ABOUT DESKTOP 

 And  COMPUTER PERIPHERALS 
 

                      You will learn 
 

 
 
 

Desktop – 

1. Desktop       2.Purpose of Desktop    3. Identify the Icon on the Desktop 
4. Start button and Taskbar       5. My computer                   6. Recycle bin 
7. Input and Output devices        8. Memory device                9. CPU 
 
 

 
 

The desktop is the primary user interface of a computer. When we boot up a computer, 
the desktop is displayed once the startup process is complete. Desktop is an area or 
window on a computer screen in which small pictures (called icons) are arranged like 
objects on top of a desk. 

It includes the desktop background (or wallpapers), icons of files and folders we may 
have saved on the desktop. In windows, the desktop includes a task bar, which is 
located at the bottom of the screen by default. 

Therefore, it may be helpful to store commonly used files, folders and application 
shortcuts on your desktop. 
 

 
 

COMPUTER FUNDAMENTAL 

UNIT- 4 
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Display Properties 

• To Change Desktop Background or Wallpaper in "Personalization" 
Settings 

 
1. Right click on an empty space on the desktop and click on Personalize. (see 

screenshot below) 
 

  
 

 
2. Click  on  the  Desktop Background link  at  the  bottom  of  the  window.  (see 
screenshot below) 

 
NOTE:The  name  in gray  under  Desktop Background is the current desktop 
background file name. 
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3. Select a Picture Location 
 

A) Click on the drop down arrow menu to select from the list of available picture 
folder locations, or click on the Browse button to navigate to the picture folder 
location.) 

 
NOTE:To use another regional wallpaper, see the yellow TIP box at the top of 
the tutorial. To remove a folder from the Picture location (not clear) 

 
B) Select the picture folder and click on Select Folder. 

 
4. Select a Desktop Background 

 
A) Right click on an available picture, or click (check) on the box in the upper left 

corner of the picture, to select it. (see screenshot below step 7) 
 

NOTE:You can continue to right click on the images to see it previewed on your 
desktop until you decide which one you like best. 

 
5. Select the Picture Position 

 
A) Click on the drop down arrow menu, and click on the picture position you want 

for the desktop background. (see bottom of screenshot below step 7) 
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6. For a Desktop SlideShow 
A) select more than one picture to create a Desktop Slideshow. 

 
 

7. Click on Save changes to apply the changes. (see screenshots below) 
 

  
 

 
 
 

Identify Icons on Desktop – 
 

• An icon is a small graphic representation of a program or file that, when 
clicked on, will be run or opened. Icons are used with Graphical User 
Interface  (GUI)  Operating  Systems  such   as Microsoft Windows and 
the Apple Mac. 

• When you double-click or open an icon the associated file or program will be opened. 
For example, if you double-click on the My Computer icon, it will open Windows 
Explorer and double-clicking a document or file icon it will open that document in 
the associated program. 
Start button and Taskbar 

 

The start Menu is used to open programs and folders, search for things on 
your computer and turn off your computer. 

 
Task Bar    

Task bar is a horizontal bar located at the bottom of the screen where running 
programs are shown when minimized represented by icons. 

My Computer – My Computer icon is a pictogram displayed on a computer screen in 
order to help user navigate a computer system. 
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My Computer Window Screen 

 

My Computer icon that is available on the desktop is use to find out the resource of your pc. 
 

My computer consists of number of icons.- Hard Disk Drive, Devices with Removable Storage and 
Network location. 

Recycle bin- The Recycle bin acts just like a dustbin. Whenever a file is deleted 
automatically it goes to the  recycle bin. Whenever a file is further needed it may be 
recovered, it is done by simply pressing the restore button in the recycle bin. 

Input and Output Devices 
 

Input device- The input devices are used for transferring user’s data to the computer. 
Some of the Input devices are 

Keyboard 
 

 
 

Light Pen, Touch Screen, 
 

 
 

Output devices- An output device is any electronic or electromechanical equipment connected to 

 
 

 
 

COMPUTER FUNDAMENTAL 

Page 23 K e n d r i y a V i d y a l a y a S a n g a t h a n 
 



 

Secondary Storage 

 

 
other media. Examples of output devices include speakers, headphones, printer and 
screen/monitor. 

Monitor Speaker Printer 
 

      

 
 

Processing 
Working on data to get the meaningful information is called processing. In computer 
calculation and manipulation is done inside the Central Processing Unit(CPU) . It act as 
brain of the Computer. 
The performance of your computer is based on simple mathematical operations. 
CPU is the device, that controls all the operations. The CPU has integrated ALU 

(Arithmetical Logical Unit). This unit is responsible for all mathematical and logical 
operations. 

 
 

 
 

  
  

 

 

In the CPU there are three separate units such as 
1. Control Unit 
2. Memory Unit 
3. Arithmetic and Logical Unit 

 
Control Unit:-The control unit is a component of a computer's CENTRAL PROCESSING  

UNIT (CPU) which directs operation of the processor. It controls 
communication and co-ordination between input/output devices. It 
reads and interprets instructions and determines the sequence for 
processing the data. 

It directs the operation of the other units by providing timing and 
control signals. All computer resources are managed by the CU (Control 
Unit). It directs the flow of data between the Central Processing Unit 

Output 
Device 

ALU: Arithmetic Logic Unit 

Registers 

Control Unit 
 

Input 
Device 
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a computer and used to transfer data out of the computer in the form of text, images, sounds, or 
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Memory Unit:- When a program is fed into the input unit, the information is 
translated into the machine language and stored in the main memory 
only on the instruction of the Control Unit. When the instruction is 
given to the computer by the user to execute the program, the control 
unit instructs the memory unit to supply the data and information to 
ALU for processing. The processed date and results are sent back by 
the ALU to the memory unit to store them in separate location for 
future use by the instructions of Control Unit. 

 
 
 
 

Arithmetic and Logic Unit:- This unit handles both arithmetic and logic operations. On 
the instructions of the Control unit and data available 
from the main memory, the ALU operates on the data and 
sends the processed results back to the main memory to 
store in separate locations. This unit does Mathematical 
(+,-,X,/) relational(<,>,=,>=,<=,!=) logical operations(AND, 
OR). 
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(CPU) and the other devices. 
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Type-I (Short answered based questions) 
 

1. What is function of Recycle bin? 
 

2. Write the steps to delete the files on the desktop. 
 

3. List any two Input and Output devices. 
 

4. What is need of Icon and draw any two Icons. 
 

5. What is brain of Computer? 
 

Type –II (Fill in the blanks) 
 

1. Mouse is a device. 
 

2. CPU can do and . 
 

3. Printer can give the output on . 
 

4. The most common Character input device is . 
 

5.   is a dustbin of your computer. 
 

Type –III (Match the Columns) 
 

Monitor Central Processing Unit 
Recycle Bin Monitor Application 
CPU Output devices 
Task Bar Printing device 
Printer dustbin 

Lab session 
 

1. Save the word file on the different location of the computer. 
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Let us do practice now 

Page 26 K e n d r i y a V i d y a l a y a S a n g a t h a n 
 



 

 

 
 
 

MS-WORD 
 

You will learn 
 

 Introduction to Word Processor 
 Features of Word Processor 
 History of Word Processor 
 Steps for starting Ms-Word 
 Components of Word Screen 
 Creating a new document 
 Opening an existing document 
 Editing text in Word Document 
 Copy, Cut and Paste, Deleting 
 Saving the Document 

 

Introduction to word processor 
Word processor processes words, paragraph, pages and entire papers. The first 
word processor were basically computerized typewriters, which did little more than 
place character on a screen, which could then be printed by a printer. 

Modern word processing program includes features to customize the style of text, 
change the page formatting and able to add header and footer, page number etc. 

Some example of word processing programs include Microsoft Word, WordPerfect, 
AppleWorks and OpenOffice.org. 

 
Introduction to Ms-Word 

 

Ms-Word - It is a program that is used for typing text. It is a part of MS-Office 
package developed by Microsoft Corporation. 
Ms-Word is part of Ms-Office Package which consists of MS-Excel, Ms Powerpoint 
etc. 

 
What can we do with the text in MS-WORD? 

 You can change the writing style, size, colour of the text. 
 The text can be highlighted by Bold, Italics and can be underline. 
 Spelling and grammars are checked and converted automatically in MS- 

Word. 

Creating Document 
 

In Word, we can create document by typing the text. The text we type is displayed 
on the screen. When the text reaches the end of a line, Word automatically moves 
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UNIT-V 
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• Press the SPACE BAR, to give space between words. 
• For a new line or paragraph, press the ENTER Key. 
• If we want to delete a word or line, we can use Backspace or Delete keys. 

 
To create a new Microsoft Word document 

 
1. Click on start  ProgramMicrosoft Office Microsoft Word to open 

Microsoft Word 2010. 
2. Select File New or press Ctrl+N to open a new document. 
3. Place the insertion point at the location where we want to type the text. 

 
Components of MS-Word 2010 

 
 
 
 
 
 
 
 
 
 
 
 

Cursor 
 
 
 
 
 
 
 
 
 
 
 

Editing The Word document 
 

Select the text 
Select means choosing the text to be formatted. Just bring the cursor in the 
beginning of the text, we want to select. 
Press left mouse button Drag the mouse till the end. 

 
The background of the selected text will become black and we will see the selected 
text in white colour. 
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to the new line and continue. 
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• Changing the size of the text. 
1. Select the text by putting the cursor in the beginning of the text drag it at the 

end. 
2. Choose the size by clicking on the arrow besides the font size box. 

 

 
 
 
 

 
 

Copying and Moving 
 

• Moving means to remove(cut) the selected text or graphic from one place and paste it on 
another location. 
Copying means to make a copy of the selected text or graphics and insert it to another 
place leaving the original unchanged. 

 
Cut – Cut operation will remove the content from its original place and move it to new 
desired location. 

 

Following is the procedure to CUT/COPY and PASTE the content in word. 
1. Select a portion of the text using any of the text selection methods. 
2. Press Ctrl+C for Copy or Press Ctrl+X for Cut . 
3. Place the cursor at the desired location where you want to paste the text and press 

Ctrl+V 
 

Saving the Document- To save a document on disk 
1. Click on office button tab. (Microsoft Word 2007 is used) 
2. Drop down menu will be displayed click on the save option. 
3. The Save as dialogue box will be displayed to type a name for the document. 

 
 

After selecting the text 
use Ctrl+] and Ctrl+[ 

 
 

Default Font size is 12. 
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CLOSING WORD 
 

Click the Office tab  close button. 
 

 
 
 

EXIT FROM WORD 
 
 
 

 
 
 

1. We can exit from MS Word by using close button of MS Window. 
 

2. Or, by clicking on Office tab -> Exit option. 

 
 

For Exit click on 
Close button 

 
 

To close word file, 
click on close button 
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Type-I(Short Answers based Questions) 
 

1. What is the default size of the text? 
2. Name the box that contains font size, font colour, font style buttons. 
3. What is purpose of MS-Word 2007? 
4. Write the steps to save a document? 
5. Write the shortcut key for cut, copy and paste. 

 
TYPE-II (Fill in the blanks) 

 

1. When we start word a new blank appears on the screen. 
2. The text can be copy by using + key. 
3. Bold, Italics, Underline buttons are placed under the tab. 
4.   is located below the title bar. 
5. Formatting tool bar contains_ , , (not 

applicable). 
 

Type-III (Match the column) 
 

 

 
Cut 

 

 Paste 
 

 
 

Copy 

 

 
 

Save 

 
 
 

Lab Session 
 

1. Type ten lines on about your school in Font size 16 and font face as Arial. 
2. Type your favorite poem in font size 30 and font face as Times New Roman. 
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Let us do practice now 
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UNIT-VI 
 
 

MORE ABOUT MS-WORD 
 
 
 
 
 
 
 

 
Formatting Text 

You will learn 
 Formatting Toolbar 
 Font    attributes-size,style,color,sub/superscript 
 Bold, Italic, Underline 
 Numbering and Bullets 
 Alignment-Left,right,center 
 Change case-sentence, uppercase etc. 
 Insert Menu –Word Art, Page Break, Images, 

Clip art, shapes, date and Time 

 
The formatting text includes – Fonts, fonts Size, Underline Style, Bold, Italic etc. 

 
 

 
 

1. Type the text. 
 

2. Select the portion of the text using any selection procedure. 
 

3. Change the font style ,font size, Grow font and shrink font of the text . 
 

Using Bold, Italics and underline Options 
 

All the three options are used to emphasize any word/ words. 
 

1. For using the above option first write the sentence. 
2. Then put the cursor in the beginning of sentence. 
3. Select the text by Shift and mouse click or shift+ arrow key. 
4. Then click on the bold button. 
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    BOLD 

Select the text and click on       
Button. Computer -----------------------
Computer 

 
    Italic 

 
Select the text and click on the    italics Button. The text will become italicized. 

Computer------------------------Computer 
 

Underline 
You can underline any word/words with this button. Select the text and click on 
this  Button. 

Computer -------------------------- Computer 
• Superscript and subscript 

 

When we have to display something like H2O or X3+Y3 what we should do ? The 
subscript displays the character slightly below the normal printed text and 
Superscript slightly above the printed text. 

Step 1: Select the text where you want to place Subscript or Superscript. 

Step 2: Click h2o(subscript) X2+Y2(Superscript)  
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Numbering and Bullets 
 

We find that while writing certain kinds of communication it is  convenient to state 
the ideas point by point. 

 

Creating Bulleted and Numbered Lists 
To create a bulleted list: 

1. Select the lines of text 

2. On the Home tab, in the Paragraph group, click the Bullets button . 
3. You can change the bullet symbol by clicking the Bullets arrow and making 

selection from the Bullets gallery 
 
 

To create a numbered list: 
 

1.  Select the lines of text 

2. On the Home tab, in the Paragraph group, click the Numbering button .  

We can change the number style by clicking the Numbering arrow and 
making a selection from the Numbering gallery. 

 

   

Bullets Gallery Numbering Gallery 
 
 

To remove bullets or numbers from a list: 
1. Select the lines of text from which you want to remove bullets or numbers. 
2. Do one of the following: 

To remove bullets, click the Bullets arrow and select None from the 
Bullets gallery 

To remove numbers, click the Numbering arrow and select 
None from the Numbering gallery. 
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The text can be aligned in the centre of the page, left, right or along both left and right 
margins 

We will find these buttons on the formatting Tool bar. 
 

 
Left (Ctrl+L) Center (Ctrl+E)  Right (Ctrl+R) Justify(Ctrl+J) 

 
Left Alignment Center Alignment 

 

  
 

Right Alignment Justify alignment 
 

  
 

 
 

Change Case- Change case command in the HOME Tab allows you to change the case of 
the characters in the text without having to retype them. Change all the selected text to 
UPPERCASE, lowercase, or other common Capitalizations . 

• Sentence case 
• lowercase 
• UPPERCASE 
• Capitalize Each Word 
• tOOGLE Case 
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Alignment of the text 
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UPPERCASE Capitalize Each Word 
 

  
 

 
Inserting the special characters and symbols 

 
Insert symbols that are not on your keyboard, such as copyright symbols, 
trade mark symbols, paragraph marks and Unicode Characters. 

Insert Menu 

 
 

Word Art- Insert the decorative text in your document. 
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Sentence Case lowercase 
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Page Break-start the next page at the current position (Ctrl+Return) 
 
 

 
Clip Art- 

 

Insert the clip Art into the document including drawing, movies, sounds or stock 
photography to illustrate the specific concept. 

Steps to find and insert clip art: 
 

1. Display the slide on which you want to place the clip art. 
 

2. On the Insert tab, in the Images group, click the Clip Art button    Or  click  the 
Clip Art button in the content placeholder. The Clip Art pane opens. 
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Images Group on the Insert Tab Content Placeholder 
 

3. In the Search for box, enter a keyword related to the desired clip art 
 

4. Click the Go button. Thumbnails of any clip art, movies, and sounds that 
have the associated keyword appear in the pane. 

5. Scroll down to see all the available clip art, and then click the thumbnail of 
the desired clip art to insert it into the slide. 

 
 

 
 

Clip Art Pane 
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Insert the ready made shapes, such as rectangle and circle, arrow, arrow lines or flow 
chart. 

Steps: 
 

1. Click on the Insert Menu. 
2. Click on Shape Button it will show Lines, basic Shapes, Arrows and flowchart and 

callouts etc. 
3. Choose any one shape and drag it into where you want to insert a shape. 

 
 

 
 
 
 

Text Box- Insert the preformatted text box. 
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Shapes- 
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Date and Time- Insert the current date and time into your current document. 
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Page number- insert page number to the document. 

Page 40 K e n d r i y a V i d y a l a y a S a n g a t h a n 
 



 

 
 

 

 

Let us do practice now 

Type –I(Short Answer Question) 
1. How do we select the line, word and letter in Ms-Word 2007? 
2. How can we make our whole document in Uppercase? 
3. List some special characters used in Ms-Word 2007? 
4. Which button would you press to align the text on both left and right margins? 
5. What is the purpose of page break? 

Type-II (Identify the following buttons 

 
 
 

 
 

 
 
 

 
 
 

 
 

Lab Session 
 

1. Create a New Document. 
 

2. Write few line about your favorite Game 
 

3. Use BOLD,ITALICS,UNDERLINE for headings. 
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INTERNET 
 
 

Internet:- Internet is a worldwide network of computers, which allows sharing of 
information. In this network, the computers are connected through cables or any other 
devices. The Internet connects millions of computers around the world. Thus Internet is 
global network or a worldwide network. 

 

 
We need Internet for 

 
1. Communication 
2. Research 
3. Education 
4. Financial Transaction 
5. Real Time Updates 

 
 

Requirement for Internet Connection 
 

Hardware- Apart from the monitor, keyboard and mouse, we have the following hardware 
requirements 

• Modem 
• Network Interface Card 
• 1 GB RAM 

Software 

• Operating System like Windows, Linux 
• Web browser like Internet Explorer , google chrome, Mozilla firefox or Netscape 

Navigator 

Steps to open Web Browser 
 

1. Click on the web browser icon. 
2. Write the website name on the address bar . 
3. Click on go or press enter. 
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UNIT-VII 
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Search Engines- 
Search engine is a software system that is designed to search for information on the 
World Wide Web. 

 
Search Engines like google, yahoo, alta vista. 

 
Finding/ Downloading /Saving images- 

 
We can search / download / save the images from the internet by using search engines. 

 
Steps to search / download / save the images 

1. Open the web browser and search engine. 
2. Type the topic related to image you want to search. 
3. Click on search button. 
4. Many pictures will be displayed choose appropriate picture and double click on image 

to enlarge its size. 
5. Right click on the image and select Save the image option. 
6. Save as dialog box will open, go to the location where you want to save image. 
7. Click on save button. 

 
 

Address Bar 
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TYPE-I (Short answers based questions) 
1. Explain the following terms: 

a. Internet 
b. Website. 

2. Write the uses of internet. 
3. Write the name of your school website. 
4. Name any two web browser. 

 

Type –II(Fill in the blanks) 
 

1. Google chrome is a . 
2. Internet is a network of . 
3.   , is a search engine. 
4. The World Wide Web is based on User Interface. 
5. NIC stands for . 

 

LAB SESSION 
 

1. Visit the school website and gather the information about your school. 
2. Visit the KVS website and collect the information about KVS. 
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Let us do practice now 
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Sample Question Paper 

FORMATIVE  ASSESSMENT-III 
 

Subject: Computer                                                                                      Class     : III 
Time      : 2:00 Hours                                                                              Max Marks : 40
 ___________________________________________________________________                                
 
Q1. Answer the following question? 
1. What is computer ? 
 
Ans:………………………………………………………………………………………………… 
 
2. What are the four main parts of computer ? 
 
Ans1………………………………… 2………………………………… 
      3…………………………………  4……………………………….... 
 
3. Write the name of 4 input device? 
Ans 
:1…………………………2……………………………3………………………..4…………………………. 
 
 
Q.2. Fill in the blanks  

Shut down , drawing ,CPU,TV, Hard disk 

1. Monitor looks like a ……………………………… 
2. Clicking on the __________________________ button shuts down the computer.  
3. Ms Paint software use for ……………………………………..pictures . 
4. ………………………is the brain of a computer. 
5. ………………………….is the example of storage device 
 
Q3. Identify the following Symbols  

 
 

 
 

 

 

 

 

 

   

 
 
Q.4 Match the following  
 1. CPU    1. Output device  
 2.Monitor   2. Central Processing Unit 
 3. Ms-paint    3. Word Processing software 
 4.Ms-word   4.Drawing Software  
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Q.5. Identify the component of Ms-Words  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Q6. Identify the parts of the  desktop  given below ? 
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Sample Question Paper 
SUMMITIVE ASSESSMENT-  II 

              Subject : Computer                                                                                                   Class: III 
              Time      : 2:30 Hours                                                                                        Max Marks : 60                                                         

Name____________________________ Sec______ Roll No______________  
Q1. Answer the following question? 

1. Which of the following is an input device      
A. Monitor  B.Mouse    C.Printer 
 
2. Which of the following is an output device is 
A. Keyboard  B.Mouse   C.Monitor  D.Joystick 
3. Which of the following is a storage device is   

A. Mouse  B.keyboard C.HARD Disk   D. Printer 
4. Which of the following is a word processing software  
 A. MS word  B.MS Excel  C. Paint   
  
Q.2 FILL IN THE BLANKS  
 
MS Word,   printer,   Calculator,   Shift key,   backspace key,  output  

 
 
A) __________________ is a program used for typing in the computers.  
 
B) ________________________ is an output device.  
 
C) A _________________________ is used to do calculations in the computer.  
 
D) _______________________ key is used to type capital letters.  
 
E) ________________________ key are used for erasing text in the computer.  
 
F) Monitor is an _________________________ device.  
 
Q.3 Identify the following icons  
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Q.5 Identify the components  

 
 
 
Q.4 Find out TRUE and FALSE 
 
1. We cannot draw picture on a computer  

2. CPU is a brain of a computer   

3. Man can do work faster than computer   

4. Paint is text typing software     

5. A computer helps diagnose diseases in hospitals  

 
Q.5 Match the following 
 

1.  CTRL+C     1.   Input device 

2. CPU      2.Copy  

3. KEYBOARD                3. Brain of a computer 

4. MS Word     4.Drawing Software 

5.Paint                  5. Word processor  
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